What’s new in

Dolphin Management

Welcome to Dolphin Management 10.6!

This document provides an overview of many of the new features that have been added since
version 10.5. This lists Dolphin Management 10.6 features followed by Specialty Module 10.6.
features followed by a new section specifically for our Canadian customers.

Please see
https://www.dolphinimaging.com/Areas/Media/Documents/MinimumReqguirements.pdf. for
complete technical specifications. Dolphin Imaging 11.95 and Aquarium 3.5 are recommended
for use with Dolphin Management 10.6.
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New Management Features in 10.6

General

Before completing an update to a new release of Dolphin Management, we now check for existing sessions,

and we open a warning message that instructs the user to close all active sessions prior to completing the

update. Users can then cancel the update and close the Dolphin Management sessions before attempting

to update the program again.

The SSN/Gov’t ID # field for patients, doctors, billing parties, and other entities includes a drop-down menu
so you can choose the desired format (in cases where you have set up the SSN/Government ID

Format/Mask on the System Options—> General tab to accept multiple formats).

We now track and log when users make changes to System Options accessible under the Tools=> Options

menu.

Alerts

You can now set up and use Quick Notes for alert texts.

Edit ?General 2Quick Notes DAlerts

Analysis

At the request of our customers, we added the Export to MS Excel option to the Practice Analysis detail

screens.

Print DExport to MS Excel

We added a new view to Practice Analysis: Open Reservations, which shows the total number of open

reservations by type, class, or all types for the given time period and location. This information from this

analysis is also included in the Complete Practice Analysis view.

Analysis DPractice Analysis DView >Open Reservations

We made performance improvements to the Practice Analysis, Procedure Counts view.

AnywhereDolphin/Dolphin Mobile/Online New Patient Forms/My Orthodontist Integration

It is now required for practices using AnywhereDolphin or MyOrthodontist to enable the integration we

introduced in Dolphin Management 10.5; we no
longer support the older integration activation
method.

NOTE: Check for activation as soon as possible
after the 10.6 upgrade to ensure that no service
disruption occurs for online questionnaires,
Dolphin MyOrthodontist, and other
AnywhereDolphin functionality.

Practices using Dolphin Mobile must configure
their server for Cloud connection type, and enter
the full 32-character enrollment number; we no
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longer support the older, 12-character enrolilment number. We recommend you use the QR code that
appears on the Dolphin Ocean Client Administration screen, as it is must faster and more convenient than
manually entering all 32 characters.

Concierge
We added a new scheduling option: Max # of openings per day to offer (0= no limit).

Edit 2Communication >Concierge Setup PMisc Options tab

Chat Message Viewer

When the employee/application right, Patient-Related Chat Messages in Patient History — View All is granted
to an employee, the Chat Message Viewer now behaves as follows: If a patient is selected, the Employee drop
down menu is enabled; if the patient is then deselected, the Employee drop-down menu defaults back to the
logged-in employee, and the drop-down is disabled.

Document Organizer

We added a new NTWAIN scanner option to the Document Organizer, which becomes available after you
enable it via Edit DIntegrations DPlug-Ins Configuration >Document Scanner. You must disable any other
scanner plug-in you are using before you can activate this one. If the computer you are using has any scanning
issues, please configure or have your administrator configure the NTWAIN scanner plug-in on that computer.

Edit Menu

e We added a new check box on the Add an Appointment Class dialog box: This is a Start, which when
checked indicates that all appointments of this class count as treatment starts; this is used for production
goals tracking, described under Financials.

e We added a new drop-down menu on the Add/Edit an Appointment Type dialog box: Default Goal To:,
from which you can select Provider, Assistant, or Location. When you make an appointment of this type,
whatever you select here will be selected by default, but you can override it at that time. This is also used
for production goals tracking, described under Financials.

e We added a new employee right Create New Timepoint Names , which, by default, is assigned to any
employee or role with the Create/Copy/Paste Timepoint and Images right. This right allows employees to
create a new timepoint name rather than just picking from the list of available timepoints, when adding a
new timepoint for a patient.

e The Partner Integration tab is now displayed when editing a doctor.

e When you set up quick notes via the General=>Quick Notes option, the Quick Note Type drop-down menu
option Day has been renamed to Day Notes for clarification.

e We added a scrollbar to the Edit a Location Options screen (Edit a Location Options button), and Dolphin
“remembers” the selected screen size.

Email

e We now support OATH2 authentication for our customers using Google Gmail. Gmail account users will not
be able to send email within Dolphin Management when Google stops supporting SMTP authorization,
which is why we offer these users the opportunity to update their Email settings. From Dolphin
Management’s Email Account Options screen, you can now access Google to grant permission for Dolphin
Management to send email from your Gmail account. A brief summary of this process is provided below:
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1. From the Email Account Options screen 2Sever Information group box, change the Authentication
Method field to OAUTH2.

Server Information

Cutgoing Mail Server (SMTP): | emtp.gmail.com

Part: Ra7
Authentication Method: OAUTHZ - Lze S5L

Provider Email Frequency

Maximum emails to send EVENY IEI minutes

2. Click the Authorize button that appears in the Login Information group box on that screen.

Lagin Infarmation

Jzer Mame: | s@gmail.com |
Authonzation: |Hem1m1.laerhﬂmnzahnn |
Domain: | |

3. When the Google WEB page opens in your browser, follow the steps to grant Dolphin Management
permission to send email on your behalf.

e You can now open the address book via the SMS/Email Manager queue in the context menu, if the entity is
a patient.

e You can now navigate to other screens while entering an email in progress without having to cancel and
close out of the Email screen.

Financials

e You can now set up and track production goals for your practice. In order to take advantage of this feature
you must:

e Have schedule templates set up and in use
e Have Appointment types/and or appointment classes set up and added to your schedule templates
e Have the new employee rights granted: Production Goals — Edit and Production Goals — View

(Edit DPractice 2Employee Rights Overrides >Financials).

' Manage Production Goals == ks Youset up production goals
f“’:m — I [ - - via the Manage Production
::mmeim;m o R o Goals dialog box
St goala by Frodc (Edit DFinancial DProduction
Descnptian Price Goal Amourt Curmert Goad Amourt % Change

Goals), which is blank until
you define your first goal

period.

What's New in Dolphin Management 10.6 31 January 2022 page 4



Each goal period is defined by a start date only; to end a goal period and set different goals, you must start
a new goal period. For example, your goals during the month of December may be less, due to holidays,
then the goals you have for other months. Once December goals are set, and you need to change the goals
for the month of January, you must define another goal period for January, beginning January 2 (January 1
being a holiday). Goal periods are completely customizable; you define the length of each goal period when
you select the effective date for the

) ) "' Manage Production Gosls [E=F 55
next goal period; goal periods can Goal Period: [Sapt - 97172021 . e 3
last months, weeks, or even days. pesmen | Rl
Fppointment Types  Aegointment Classes
. . Description Prior Gl Apscurt Cument Goal Amount i Change L
Once you define a goal period, the ’
. BAND - Banding
Appointment Types and BB.2- Broken Bracker
. BiB-3 - Brokers Braciet
Appointment Classes tabs are =
updated with the appointment types G LN T W—

and/or appointment classes in your database, respectively.

From here you can either set goals for different practice locations, or set default production goals (<Default
for All> above) and then copy those to one or more locations.

When you first set goals, you click in the Current Goal Amount column to enter the goal amounts for each
appointment type or class listed. As you add more goal periods, the Prior Goal Amount Column and %

Change columns are updated automatically.

" Manage Production Goals (=R ECR ()

Goal Period: | December 2021 - 12/1/2021 ~| |E3 H

Locatior: | <Dctautfor Al> . From here you can add more goal periods,

“orment T Hepsinert oeee and Dolphin prompts you to copy the goal
Description Prior Goal Amourt Current Goal Amourt % Change &

, 20000 200000 00 values from the current goal period. You can

BAND - Banding $30.000.00 $24,000.00 -20.00% v

= also use the button to copy the

values from a specific goal period to a new goal period.

1. To set schedule template goal amounts, select a location from the Location drop-down menu. The
Schedule Templates tab appears, populated with the schedule templates for the location you selected.

2. For each schedule template Schede Tengistes fppamtmert Types  Apporment Classes

[ St goals by Preduction Emgloyee

listed, enter a value in the

Description Prior Goal Amourt Change
Current Goal Amount ’

Tistadiay - Thursday Chatevorth
COI umn. Widnesday - Chatrmarth

You also have the option to track goals for each employee defined as a Production Employee in your
practice. Dolphin provides a starting point for this entirely customizable option, and you decide how you
want to use it. This option becomes available only after you entered goal values on one or more schedule
templates.

1. Onthe Schedule Templates tab, click to check the Set goals by Production Employee check box.
Instead of a list of schedule templates, a list of employees defined as Production Employee appears
under the Description column.

2. Click the button.
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A list of employees defined as Production Employees appears under the Description column, with the
Current Goal Amount column completed based on the Current Goals Total divided by the number of
production employees.

The Current Goals Total is calculated based on:

The current goal amount for each Appointment Type/Class on the Schedule Template multiplied by the
number of appointments of that type/class on the schedule template.

3. For each production employee listed, click in the Current Goal Amount column, and modify it as
desired.

When you set up production goals, you can quickly view them on the Schedule using the new Goals tab on
the schedule widget.

We now include the latest CDT code set for our United States customers. When you update to Dolphin
Management 10.6, the Default Code Type field on the System Options, Financial tab is automatically
updated to CDT 2022 Codes, which are then populated throughout the product.

Insurance

We now offer electronic insurance claims processing for Canadian customers through our CDAnet
integration. This is described under What’s New for Canadian Customers.

When you set up the insurance benefit, we now require you to enter an expected monthly amount when
you choose the Accept Assignment option.

We now include the standard ADA 2019 insurance form for paper insurance claims in the United States.
Any employer plan or insurance policy previously configured to use the ADA 2012 insurance form has been
updated to use the new form.

When you update a patient’s insurance policy information, or add a new policy for a patient, and there are
other patients associated with the same billing party under the same employer plan, we now prompt you if
you want to update the policies for those other patients as well.

We clarified the message box that appears after users post an insurance overpayment. The Insurance
Overpayment message box now presents the following two options:

e Apply to Remaining Benefit — Use this option if the insurance overpaid the expected benefit charge, or
there is no charge in the total due, and you want the credit applied to the unbilled benefit. Check to
adjust the next form date, if needed.

e Do Not Apply Insurance Credit toward the Remaining Benefit — Use this option to apply the credit to a
charge you expect to post within the next few weeks.
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e You can now create an orthodontic Predetermination claim from either the Edit a Patient screen or the
Patient Treatment/Contract Proposals screen. In prior releases, you had to complete the insurance benefit
first. Now, you can now access the Insurance
Claim screen from the Patient
Treatment/Contract Proposals screen and the Edit

Treatment Fee Code |

a Patient, Insurance tab, Policy Information group
box via a new Send PreD/Send Ortho PreD button.
Depending upon whether you have set up the

Treatment Fee |E—D.I}D

Estimated Treatment Start Date |5,-f1 G/2021

Estimated Treatment Months |I} insurance policy and treatment yet, the following

screen appears with that information completed

Initial Fee (Optianal) |5.[:-_|}[:-

for you. If you have not provided that information

Freguency Amount (Optienal) |SD-DD anywhere in Dolphin, enter it here, then click Save

to open the Insurance Claim screen.

Save On the Insurance Claim screen, simply click OK to
create the claim and add it to the insurance claims

queue.

e We have added the Time of Service option to the Edit an Employer screen—>Employer Plans
tab—> Continuation Frequency drop-down menu. This corresponds to the Continuation Frequency option

(added in a previous

Z EdifaPatient=lsamantha (Sam) Jones [970992] DOB 2/2
release) on the Edit a 7¢) _
Lookup | View Sched “ Edit an Employer - Delta CA
Patient Patient (more} S L_'

Patient—>Insurance tab.

e Atthe request of our Paiicy Ifomation | Documents
Billing Party. MName: |De|ta CA |
customers, we added a EmployerPlan  [0d :
Address Employer Plans | |ocations
. Insurance Carrier | ()
View Plan button to the oo Erones M9 octoca e
. . - " Mame: Detta CA | ] Prirt This Diagnasis on all Forms
Ed it a Patlent% I nsurance ::::i?ol:iy: E Billing Center 1064 - | ] Print This Diagnosis f Missing on Treatment
. . . . Print Signature on File to Release Records to Insurance
ta b 9 Pollcy Informatlon Group Mumber: |: zro;p :;mbtarl. e Pre-Determination Form Required
H H MedicaliDental: D; ceiealbentat e Initizl Form Required
group box. Click it to open " ProcedureCodeTyps  |CDTI2Codes - [+ Continuztion Forms Required
. || Diagnosis CodeType ICD10 w [] This is Medi-Cal
the Insurance plan for that .- Insurance Form: ~ [[] This is Blue Cross/Blue Shield
pat|ent Continuation Frequency: | Manthly - [ Accept Assignment/Create Ledger
Continuation Code | = | Show Accept Assignment on Forms
° At the re uest Of our ] - [[] Show as Secondary/Cther Ins. on forms
q met Cnérges on Fom: | By Morth [ Hide Additional CDT Codes on Initial Claims
customers, we added a Biagnosis Code | | _
— | InsuranceType Group Health Plan ~ Comment
new check box, Minimum P oo B ecvonicpavers ||
. Fastattach Payer Mame: l:l
of 90 Days, which appears l
when the Continuation P [otno B
Frequency is set to

Quarterly. This ensures that claims are not sent out before 90 days have passed in cases where an
insurance company will reject a claim when a quarter includes short months, which causes fewer than 90
days between claims.

e We made the following enhancements to the Insurance Claims queue:

e When you edit a claim and change the date, we now prompt you if you want to change the date on all
items tied to that claim, provided there is more than one item.
e You can now double-click on the grid to edit a charge.
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Ledger

e Atacustomer’s request, we added a Pmt Methods button on the billing party ledger. This button is visible
to employees who have the right to edit credit card numbers (Employee Rights DFinancials >Credit
Cards > Edit).

{®) Patient () Billing Party Related Patient(s}

Patient: |West, Danielle = | West, Faith
West, Stephen

Pmt Methods West, Warren

e You can now right-click on an unbilled insurance benefit, and adjust it, even if the balance is $0. This makes
it easier for practices to fix the ledger when they accidently write off the entire insurance amount. This
applies to started benefits only.

e When you attempt to transfer a payment on the same day you post it, we now display a message box
informing you that you cannot do that prior to End of Day. After you click OK on that message box, the
Transfer Payment screen opens where you can only do a reverse/repost.

e We added an OrthoBanc icon to the billing party ledger just below the Patient/Billing Party chooser field for
those patient/billing parties linked with OrthoBanc.

e We now show a tool tip that shows the billing party and insurance company phone numbers including
notes when you hover over their tabs on the ledger.

o The Total Payments field at the top of the Ledger has been replaced with two fields: Gross Payments and
Net Payments. As part of this enhancement, we added a new system option, Subtract Refund Adjustments
from Net Receipts (Tools 2>Options DFinancial tab)

o When you print the Ledger, and you have disabled the Show Orthodontist Changes option, that
information no longer prints.

Letters

We added the letter token TodayMonthDayYear, which outputs the month name, ordinal day and year, for
example: August 11, 2021.

OrthoBanc Integration

e We added a Location Name column on the OrthoBanc Setup Wizard—> Existing Provider Account Setup
page. This was added to differentiate the same provider working at multiple practice locations.

Patient GPS

o The Chair(s) list box now shows each chair with the location appended to it on the Sign-In, Patient GPS and
Light Bar Locations and Chairs screen.

Patient Information

o We added a Status column in Patient Lookup that shows the patient’s status in the colors associated with
the that status.

e We enhanced the Billing Party Lookup screen, that appears when you add a new patient, and associate
that patient with an existing billing party:

e The section containing the check boxes is now scrollable.
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e |[f the selected billing party has active insurance policies associated with existing patients, you now have
the option to copy those policies to the new patient, via the new Insurance Policies to Copy group box.
Simply click to check the policy and all of the information from that policy will be copied to the
insurance policy for the new patient.

e When you add a sibling for a patient who already has an insurance policy on file, you can copy the existing
patient’s policy over to the new patient via the new Copy From button.

e We added a Questionnaire option to the standard right-click menu, which when selected, opens the
Questionnaire or Super Questionnaire dialog box for the patient in context.

e We added a Termination Date field to the Edit a Patient, Insurance tab, Policy Options sub-tab. This is
populated with today’s date when you click the Policy Inactive check box, or you can enter a date in the
past, and the Policy Inactive check box is automatically checked.

e As part of the previous enhancement, The Billing Party drop-down field in Patient Comments now includes
the policy group number, and appends ** to any policies that are currently inactive.

e We added a Send Ortho PreD button to the Edit a Patient, Insurance tab, Policy Information group box:

O O |
Fatient | Fatient jmore) | Status | Felationships | Bling Parties | Insurance
Policy information Subescrity
Billing Party a r Hame
Employer Plan Db - Sandand Flan | o
Insurance CAMIS By o Crmas - Blos Shisld Birthoa
Sl L L Genda
BilingPolicy®  ga7 g 4324 Addres
Patient Palicy #
Group NumBer 45345345435 City
O MedicalDental: | pagtal w|| Sate M
[Send Ot Pral) Jf| Show Claims | | Pnons
T Empla
Marital
Relatio
B Cross - Bhue Shiekd Pmdd 5 Flokey> |
L ] LI

This button does not appear if the policy on file is marked as inactive.
e We enhanced the process of adding a new billing party to a patient record:

e If the patient is 18 or older, and has not been added as “self” in the Billing Party fields, the following
prompt is displayed:
“Would you like to copy the patient’s personal and contact information to this billing party?”
If you click Yes, the following information is copied from the patient to the new billing party:
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Name
Sort Name
Gender (from the Identifies As field, if set, or from the Gender field)
Greeting
Birthdate
SSN
Address
Phone Numbers
Email Addresses
Mail Method
Language
e If the patient is under 18, the following prompt is displayed:

“Would you like to copy the Patient’s contact information to this Billing Party?”
If you click Yes, the following information is copied:

Address

Phone Numbers
Email Addresses
Mail Method
Language

We improved the speed when opening Edit a Patient over VPN.

As part as the CDAnet integration for our Canadian customers, we use the Edit a Patient, Language field to
determine the language to use when generating certain reports. All reports are generated in English by
default; however, we anticipate being able to use this feature for other languages in the future. Currently
we support French for Canadian customers using the CDAnet integration feature.

Reports

We created a new report for customers using the Hummingbird reports: All Non-Zero Insurance Accounts,
which includes the following columns, not in our standard All Non-Zero accounts reports:

Last Proc
Last Proc Date
Next Proc
Next Proc Date

We modified the Hummingbird Morning Huddle Report to always pull data as of the current date,
regardless of the selected report criteria date, so that the data for active patients without an appointment
matches what is in the “Patient in Active Treatment Statuses without a Future Appointment” report. We
also added the statement “This section is as of today” to the Morning Huddle Report for clarification.

The Hummingbird Start Needed Status, Growth Guidance Phase Il Pending, and All Status reports now
include the following columns:

e lLast Message Date
e lLast Message
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e last Email Date
e Last Email Message

We added the Patient Insurance Termination Date field to the Patient Insurance field category in DIRT.

We added the Appointment Type Minutes field to the Schedule field category in DIRT.

At the request of our customers, we added the following fields, sortable by date, so they can sort on when

an appointment entered the most recent status

e Appointment Status Date Time

e Last Appointment Status Date Time

e Last Dismissed Appointment Status Date Time

e Next Appointment Status Date Time

o Next Appointment Including Today Status Date Time

Schedule

The Search Schedule now allows you to search on Any Reservation, a new
Search By option.

This searches for any open type and/or class reservation that meets the other
search criteria you enter. The search results include a Type/Class column that
lists the type or class of any open reservations found. You can right-click on
an open reservation and further refine the search based on the type or class
of that reservation, and find other appointments of the selected type or
class.

When you click on Today button, the schedule is refreshed.

If your practice has set up, and you have permission to view production
goals, the Schedule widget now includes a Goals tab. Here you can view
productions goals for a specific employee or all employees, again depending
upon your application rights. See Financials for information on setting
production goals.
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You can now control whether patients are put on recall automatically after an appointment cancellation via

a new System Option:

Tools POptions DScheduling tab—> Put patient on Recall when cancelling an appointment, by default

You can now specify whether you want Dolphin Management to require staff to specify whether the

patient or practice cancelled and/or rescheduled an appointment, via two new system options:

Tools POptions DScheduling tab

e Require staff to select who (patient/practice cancelled an appointment

e Require staff to select who (patient/practice) rescheduled an appointment

These are un-checked by default. When checked, the appointment cancellation prompt will no longer

default to “By Patient,” but instead require the user to actually select either the By Patient or By Practice

radio buttons to complete the cancel or reschedule request.
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At the request of our customers, the Dismissed Appointment Time field in the School Excuse now uses the
actual time the appointment was dismissed, rather than the scheduled or printed dismissed time. This
allows offices to print accurate school excuses for past appointments.

You can now print a school excuse for an appointment that occurred in the past. Simply right-click the
appointment in the patient’s appointment history, and select Print School Excuse.

We added a Weeks Out column to the patient appointments list (Edit a Patient DAppointments tab),
which shows the calculated number of weeks out from today (for future appointments only).

We added an Early/Late column to the patient’s appointment history grid. This shows the number of
minutes a patient was early or late at sign-in, or the number of minutes late a patient is for an appointment
on today’s schedule.

You can now enter Day Notes or Block Notes that span across multiple days. On the Day Note screen, you
can now enter both a Start Date and an End Date for each note. Specify an end date that is greater than
the start date, and the Day Note or Block Note will appear in the schedule across every day in the given
date range.

When viewing a patient’s appointment history, you can right-click on a scheduled appointment and access
the Confirm or Unconfirm options.

We added a new per-user option under the Options tool bar button: Automatically load selected
appointment’s patient in Patient Navigator. When the patient navigator at the bottom of the schedule is
visible, and this new option is checked, any time you click on an appointment in the schedule, the
associated patient’s information is loaded into the patient navigator.

We enhanced the Checkout wizard in the process of fixing a problem with future appointments and NVs:

e We clarified the labels to indicate whether an appointment was scheduled and the scheduled date.

o If the Next Visit appointment has already been scheduled, the Search button is disabled.

e If you highlight an appointment in a list, and that appointment has already been scheduled, the
Search/Schedule button is disabled.

Schedule Templates

At the request of our customers, we added a new way to apply schedule templates to their future
schedules. On the Apply Template screen, in the new Update Type group box, click the Mass Update radio
button to open a list of options (shown enlarged in the screen shot), which you can use to quickly
customize and apply templates:

What's New in Dolphin Management 10.6 31January 2022 page 12



Update Typs
() Calendar () Mass Update

Selection Type

(W) Selected Template

(T} Templates from salecied wesiis)

Selecton Range

Apply to seleched daleranpe

M T W Th F

D08 8 &0

Every |1 ¥ Weeks

Mext Morth bl
Apply e salsstad daye s e

ca

In the Selection Type group box, you specify whether to use the current
selected template or Templates from selected (week(s) drop-down

menu.

Use the options in the
Selection Range group box
to apply the selected
template or templates from
selected weeks to the date
range you specify.

After you click the Apply
button, Dolphin
Management opens a dialog
box listing the selections you

== made, and prompting you to

confirm these selections.

After you click Yes to confirm, you will still have the option to undo the last
mass operation.

e Every time you apply a schedule template mass update or undo a mass update, Dolphin logs it in the
Database Log Viewer.

Tools DView Database Log

Scheduled Job Manager
We added a new scheduled job for sending mass online questionnaires. (Tools 2Scheduled Job

Manager >Task 2Automated Questionnaire Messages).

SMS Messaging Center

We added an option available to the administrator role only: the ability to mark unread messages addressed to

all employees as read and refresh the Inbox.

Right-click Inbox Remove Unread Message Flags.

You are then prompted to enter a date before which any unread messages addressed to all employees should

be marked as read.

Treatment Card

e We enhanced the editing capabilities of any treatment card field specified as This is a “Remarks”” Field on

the Treatment Card Layout. When editing this field in the treatment card:

e Keyboard arrow keys move the cursor within the text notes rather than the active cell.

e Control +Left Arrow and Control + Right Arrow keystrokes move the cursor to the beginning of the

previous or next word in the notes, respectively.

e Control +Shift + Left Arrow selects characters from the current cursor position to the beginning of the
previous word. If the cursor is in the middle of a word, the characters at the beginning of that word are

also selected.
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e Control + Shift + Right Arrow selects characters from the current cursor position to the beginning of the
next word. If the cursor is in the middle of a word, the additional characters are also selected.
e Control +Z and Control + Y undoes or redoes the most recent change.

We have integrated with Change Healthcare’s electronic prescription module, Clinician. When this
integration is set up, a new Clinician toolbar icon appears on the treatment card. When you click this
button, the patient is opened in Clinician, and you can create a prescription there. Any prescriptions
created in Clinician will appear in the treatment card grid with a Clinician icon.

Note: If you are interested in Beta testing this integration, contact us at DMBeta@dolphinimaging.com.

We now show the appointment start time in the treatment card grid when you show Past Appointments
(Options DShow Entry/Field Types DPast Appointments).
You can now add a sibling patient directory from an existing patient’s treatment card! From the Patient

tool-bar button cascade menu, select the new Add Sibling — Treatment Card - Danielle West [160219] DOB 12/1
Patient option. One of the following occurs: o o s

Mew Teeth Lookup Patient Apptsv D/ | Co

e If the current patient has one billing party only, the Billing - _  Patient Info
Party Lookup screen opens where you can select the History

- . . . Status Inf
billing party information to copy and then go directly to 220208 [ atusinte
. 21972013 Tracking Dates
the Add a Patient screen. - - _
. . Treatment: .. Add Sibling Patient
e [f the current patient has more than one billing party, you Dertict Reload this Patient

are prompted to select from the billing parties associated
with that patient, before the Billing Party Lookup screen opens followed by the Add a Patient screen
as described above.

You can now copy and paste treatment card notes from a previous Visit entry to another. Simply click and
highlight the text you want to copy, press CTRL+C, then click in the field you want to copy, and press
CTRL+V. Copy and paste options are also available in the right-click menu for treatment card text entries.
When a patient is within 6 months of completing treatment, the progress bar in the treatment card header
turns yellow.

We improved the way user application rights work when a user does not have permission to edit textin a
treatment card text column.

We improved the performance of loading global treatment plans.

Zuelke Financial Expert

We added a prompt that is displayed when a user clicks the ZACC button but does not have a username or
password for ZACC. Employees need to be set up to use the ZACC feature prior to attempting to get a
credit report by clicking ZACC (Edit a Patient 2Billing Parties tab-> Financial sub tab).

The Zuelke Case Start Tracking Form A report no longer includes fully discounted treatment starts for which
the rating was Not Rated. These starts show up on the B/C reports.
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New Features in Specialty Module 10.6

Analysis

On the Dolphin Management Practice Analysis screen, when you select a specialty filter, we automatically
select the provider associated with that specialty.

You can filter the Open Reservations module (in Practice Analysis) by specialty.

You can filter the Procedure Counts module (in Practice Analysis) by the specialty of the scheduled
appointment type.

The Treatment Card Procedure Counts includes only appointment types assigned to the selected specialty.
It also applies location and provider filters against patients’ normal location and provider for assigned
specialties.

Edit Menu

We added a new check box to the Add/Edit a Charge screen: Show Code and Description on Ledgers. This
option is on by default.

We added a new tab to the Add/Edit an Employee screen that appears only if the employee Type (Add/Edit
an Employee—~>General tab->Type field) is set to Provider: Provider Network Settings. This tab allows you
to quickly specify whether the employee is In-Network or Out-of-Network for each employer/insurance
plan combination listed. The default for each plan is Not Set.

Dental Treatment Chart

The charge grid includes two new tabs on the left side: Current and Future and Prior Work (See Chart Prior
Work below). The Current and Future tab is where you chart current and proposed procedures/charges the
way you did in version 10.5. The Prior Work tab is described in the following section.

You can now print dental proposals from the Dental Treatment screen.

We added quick selection buttons at the top of the Choose Tooth and Surface(s) screen, so you can quickly
apply common multi-surface combinations when selecting a charge that requires you to specify two or
more surfaces.

Tooltips on each button describe the surfaces to which the button corresponds. For posterior teeth, the
possible buttons are MO, MOD, DO, OL, OB, MODL, and MODB.

For anterior teeth, the possible buttons are MIFL, ML, MF, DIFL, DL, and DF.
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ﬁ Choose Tooth and Surface(s)

D2160 - Amalgam - three surfaces, pnmary or permanent

Select a Tooth Select Three Surfaces
MO MOoD oo

oL OB

Chart Prior Work

We added the ability to chart work that was performed elsewhere, prior to today, such as work based on
information from patient records, interviews, or questionnaires.

From the Treatment Card, select
the Options button—>Screen
Setup, Colors and Fonts. Click the
Charge/Code: |Ama|gam—one surface, primary or permanent b new Prior Work check box on the

Date: 12rg,f2u2| : i | Screen Setup tab.

E Prior Work [tem

To chart prior work, from the
Dental Treatment chart, open the

Pick
Surface(s): |:| m Prior Work tab. Right-click
[Pick

Tooth: |L|p|':|-er Left 1 |

anywhere on the Prior Work tab to
open the Prior Work Item screen
shown at left. You also have the
option to drag and drop items from
the Charges or Codes list to the
grid or to a tooth in the chart.

Area: MIA

Maotes:

Once you add items, they are

m shown on the Prior Work tab
highlighted in green. Any prior

work already charted performed at

your practice appears there highlighted in blue.

Ledger

We added a new check box on the Transfer To portion of the Transfer Charge screen: Do Reverse/Repost vs
Transfer. Click this if the payment was posted in error, and you want the transferred payment to be counted
toward the transferred-to account when you run the “Provider Collection of Production By Employee” report.

Letters
We added the following new letter tokens:

AppointmentSpecialty
AppointmentSpecialtyDoctorType

Location Security

The Specialty module now supports location security, which when enabled, the office locations you set up will
be available only to those employees to whom you grant permissions for each location.
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Patient Information

We added a Status column in Patient Lookup that shows the patient’s status in the colors associated with the
that status. We also added colors associated with the specialty to the Specialty column in Patient Lookup.

Periodontal Charting
We now include a periodontal chart, which you can make available via a new treatment card field:

1. In Treatment Card Setup screen, edit the treatment card layout where you want to add a periodontal
chart.

On the Fields tab of the Treatment Card Layout you are editing, click Add to add a new field.

On the Treatment Card Field window, Field tab, Field Type drop-down menu, select Perio Chart.
Enter a name and description for this column.

vk W

Save your changes

When you open a patient’s treatment card to chart a visit using that layout, the following icon appears in the

new column: ===
6. Click on that icon to open the Perio Chart.
Note: If you have not set the patient’s dentition in either the orthodontic or dental treatment tooth chart, a

message is displayed prompting you to do that first. The periodontic chart honors the dentition specified in
the most recent treatment card entry.

In the example shown below:

Four rows of teeth are displayed, as noted on the vertical labels on the left side of the chart. Additionally,
each tooth is divided into 3 sites where you can input values or attributes corresponding to depth
measurements or other observations you make along the gum line of the tooth.

The Arch Visibility group box Perio Chart - Céleste G Férme [21023] DOB 3/19/1962 - A Dentist - Chatsworth

. PocketDepth02010017100000000201 oooo000OOOOOOOOOOOOOOOOOOOQOO rch Visibilty
controls which tooth arches show |, e 0000 008508685095 90 HB85508850888508880088550885 I,
on the chart. The default is both an EAQ.&;.LAL EJ;L Tl D
. . ﬂ;:,, | [ Packet Dept
Maxillary and Mandibular. 2 | e
3 18 17 16 15 14 13 12 11 21 22 23 24 25 26 27 28| X Aechmentioss
The check boxes in the Inputs & [ ' ' {4 || s
z Lilindiiilans =
sh : QBQ—A—_LL £ _a_ _EL S Q_Q C] Celoules
own group box control which 1 " 1 Furcation
. /
inputs you want to show on the | e g e
h h d h Aitachment lLoss000000000000000000000000000000000000000000000000 nmm
chart. You can chart and thus ek S,
show any of the following inputs: Y EAENENEN
O Enable‘.ﬂoioa Entry
¥ WWW?’?’ AEV‘E"E"E’ ‘?‘EWWW Erable Voice Feedback
e Pocket Depth 3
. - 48 47 46 45 44 43 42 41 31 32 33 34 35 36 37 38 5 "
e Recession 5 |
. = _ﬁ_ —'r |
e Suppuration |
Pocket Depth 0 l)(]IJUIJl)(]I]DUUGDUDUUDUDDUUGDDDUUDUDUUUGDDUUGUUDUﬁ‘
) Calculus Recession0 00000000000000000000000000000000000000000000000
Aitachment Loss000000000000000000000000000000000000000000000000
° Furcation | ox |

The Attachment Loss input is a read-only value that shows the sum of Pocket Depth and Recession values.
7. To chart:
a. Click on arow above (or below) the tooth you want to chart.
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10.

11.

A blue box surrounds the active rows associated with that tooth, and the following toggle buttons
appear:

Calculus

b. Click in the row on which you want to chart.
c. Click a number a value on the blue numeric keypad to place that number on the active tooth.

Note: Values you enter are color-coded as follows:
e Attachment values and bar graphs less than 3mm are green, 3mm are yellow, and 4mm or greater
are red.
e Pocket Depth values less than 3 mm are green, 3mm are yellow, and 4 mm, or greater are red
e Recession values less than 2mm are green, 2mm are yellow, and 3mm or greater are red.
As you chart, you can toggle inputs for Bleeding, Suppuration, and Calculus,
Or
use keystrokes.

Example: enter S to toggle suppuration on or off.

13

Tooth site attributes are charted graphically as follows:

e Bleeding: sold, dark red circle
e Suppuration: solid dark cyan triangle
e Calculus: solid dark yellow square

Optional: To change from the default tooth numbering system (the one assigned to the employee doing the
charting), right-click on the chart, and select a different TNS from the menu that is displayed.

Optional: If you have a microphone or headset connected to the computer, click the Enable Voice Entry
check box to enable charting using voice commands. The charting site must have focus before you speak
any of the following voice commands:

e “zero” through “fifteen” to enter the value spoken and advance to the next tooth site.
e  “minus” spoken before a number command to enter a negative value.
e  “back” or “previous” to move the input focus to the next tooth site.

Optional: if you enabled voice entry, click the Enable Voice Feedback check box if you want each command
read back to you for verification.

You can easily keep track of which treatment card entries have periodontic charting because a small green dot

appears on the Perio chart icon to indicate it: | m 1.
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You can print a copy of the chart, or save it in .PNG format via the Print and Save As buttons respectively;
charts are saved in the patient’s Documents folder by default.

Reports

The Daily Schedule and Collections report now returns balances for the appointments of the selected specialty
only.

Schedule

e You can now assign a specialty to appointment types and appointment classes, and we have added a
Specialty field to the Appointment Classes, Appointment Types, and the Add/Edit an Appointment Class
and Add/Edit an Appointment Type dialog boxes. The default for the Specialty field is All.

When you edit or add an

appointment class, the list of B8 Add an Appointment Class B8 Add an Appointment Class
available appointment types Class Info  Appeintment Types Class Info  Appointment Types
e . Available Types Code:
is limited to those — o |

. . Code Class Description Description: |
appointment types assigned -

. Inutes:
to the selected specialty. CLEAN Cleaning
. . CLN DENT Cleaning Color, ChooseCoIor
Additionally, if you change Bz
. . Specialty: Pediatric Dentist ~
the class-assigned specialty - : e ey
. |

and you have appointment

types assigned to that class,
a pop-up message is displayed so you can confirm you want to remove those appointment types from that
specialty.

When choosing a class to associate with an appointment type, you must choose a class assigned to the
same specialty. If you change the assigned specialty, the class selection is cleared.

Edit ?Scheduling ?Appointment Types
Edit DScheduling ?Appointment Classes

e We automatically assign a default specialty to all appointment types and appointment classes, based on the
following rules:

Appointment Types:

Assign specialty that matches the specialty of the most recently-entered appointment on the schedule;
otherwise use the specialty that was first enabled by the practice.

Appointment Classes:

Assign the specialty that matches the specialty of the first non-deleted appointment type assigned to the
appointment class; otherwise use the specialty that was first enabled by the practice.

e When you make an appointment, the Appointment Type field selection behaves differently depending
upon the specialty assignment made on the Appointment Type (Edit >Schedule DAppointment Types):

o The field is disabled until you select a patient for the appointment.
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e When making a patient’s appointment from a reservation, the appointment’s specialty is defaulted to
the specialty assigned to that appointments class or type if the patient is also assigned to that specialty.

e |f you switch to a different specialty while the Appointment Type and patient is selected, the
Appointment Type field is cleared unless the selected appointment type is also assigned to that
specialty.

e When you override the reservation, the Appointment Type lookup will show only appointment types
that match the specialty.

e A warning message is displayed if you make an appointment of a type not assigned to the selected
specialty if the patient is not assigned to that specialty.

Tools Menu

We now include a Specialty drop-down menu on the Move Locations and Providers utility tool. You must first
select a specialty, which filters the From Provider and To Provider lists to include providers in that specialty
only.

Treatment Card

In Treatment Card Setup >Treatment Card Layout >Treatment Card Field, the Appointment Types and Next
Visit Appointment Types fields includes a new option, Filter by Layout’s assigned Specialty, which is not
checked by default. When you check this field, the appointment type selection is limited to the appointment
types assigned to the same specialty as the treatment card layout you are using. For example, if you are on a
treatment card layout for Pediatric Dentistry, the appointment types available are limited to those assigned to
the Pediatric Dentistry specialty.
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What’s New for Canadian Customers

CDAnet Integration

For our Canadian customers, this section describes how to set up Dolphin CDAnet Integration and use it to send

electronic claims. Before using this new feature, your practice must have:

e CDAnet software installed.

e Canadian charge codes entered in Dolphin.

e set your Default Code Type in Dolphin to be the code type required by CDAnet.

e the CDA billing and treating provider numbers handy for those employees responsible for electronic claims
processing.

To set up your practice, you must configure:

e CDAnet plug-in

e Practice location

e Employees

e Insurance Carriers

e Directory watcher scheduled job

Step 1: Set-up your Practice:

1. From the Edit menu, select integrations—>Plug-Ins.

2. Inthe Plug-in Type list box, select Insurance Claims.

3. Select CDAnet from the Configured Plug-Ins list box, and click Add.

4. Click Settings to open the CDAnet Settings dialog box, and complete the following fields:

e Directory to Read and Write Files is

CDARet Settings
the directory on your machine where
CDAnet writes transaction files, Directory o Read and Virite Files: [CACA | Choose |
where Dolphin Management will look R ' el ]

Orthodontic Codes

for them, and where Dolphin

PreD Code 53341
Management writes claims for niial Code (93303
electronic processing by CDAnet. Files - Monthiy Code (33332
in this directory are either named iy Ton [
Annusl Code
Input.xxx or Output.xxx 1
e Next File Extension identifies each
. . . . I | 0K J Cancel |
file by a numeric extension, which 1 T —

updates until it reaches 999 before starting over.

e If you entered the CDAnet approved electronic codes prior to opening the CDAnet Settings screen,
Dolphin automatically populates the codes for you in the Orthodontic Codes group box; otherwise,
you must first create these service codes, then manually enter them here.

Note: customers in Quebec have a different set of codes than those we show above.

5. Click OK.

6. From the Edit menu, select Practice> Locations, and select the location to edit.
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7. On the Edit a Location screen, Enter the number CDAnet uses to identify your location.

CDA D |1234 The Sequence # field is read-only, and it is associated with each
Sequence# | oo transaction.
8. Click OK.

9. From the Edit menu, select Practice> Employees.

10. Click the IDs tab.

11. In the CDA Provider Numbers group box, enter the CDA
billing and treating provider IDs for each employee who
has one.

12. Optional: if there is an insurance carrier number assigned
to an employee, enter it here also.

Step 2: Add or Edit Insurance Carriers

Dolphin’s CDAnet integration includes a lookup list of all
supported carriers. You should either edit any existing carriers

CDA Provider Numbers
Default Treating CDA Provider Number: | |

Default Billing CDA Provider Number. | |

CDA Provider Number Location Insurance

| Add i =diE |

you have and link them to the approved CDAnet carrier in this list, or add a new carrier. All of the information
about that carrier will be imported into your system. To access this list:

1. From the Edit menu, select &
Financial->Insurance Carriers. [C

Documents.

2. Select the carrier you want to edit, or click  camername |

New to open the CDA Carrier Lookup, i | — -

. . . clect: CDA Carrier Lookuj X
which includes a list of all Supported Select
carriers Please Choose a GDA Carrier

: [ a1

CDA Carrier Hame: CDA Carrier ID Al

For each carrier you add or edit on this DSAIberla Dental Services Corporation (Alberta Employment, immi
. . Alberta Blue Cross 000050
screen, you can click on the View button Assacition s paiséres et poicers du Québes ez
Assumption Life 610181
to see a list of supported transaction Autaben 2615t
Benecaid 810708
Benefits Trust (The) 610145
types' Canadian Benefit Providers 610202
ClaimSecure 610098

Co-nnerators (The) A06DER hd

Step 3: Set up the Directory Watcher Job

1. From the Tools menu, select Dolphin Scheduled Job Manager.

2. On the Scheduled Job window, enter a name for the job your practice will use to monitor the CDAnet
read/write directory you entered on the CDAnet Settings dialog box.

3. Inthe Task field, select the CDAnet Response File Watcher from the pull-down menu.

4. Set the Frequency to Daily.
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5. Enter the directory to watch (the
CDAnet read/write directory).

6. Inthe File Mask to Watch field,
enter output.*

7. Click to check the Check if Any Files
Exist check box; this ensures that in
the off chance any files are already
there, Dolphin processes these files
before looking for new files.

8. Click OK.

Step 4: Electronic Claims Processing

The Edit a Patient screen, Insurance
tab includes 3 new fields specific to
Canadian practices whether or not you
use CDAnet:

& Scheduled Job

Job Settings
Name: cda response watcher
Computer: GCGBKT2-LT =
Task: CDAnet Response File Watcher ~
Start Date/Time: [4/30/2020 ~|[23103PM |
Schedule Settings
Frequency: (O 0One-Tme (O Sub-Daly @ Daily (O Weekly (O Monthly
] Recur every: day(s)
[ Expires on:
Enabled
Directory Watcher Directory to Watch: |C:'-.ICA'-. |
File Mask to Watch:
Check I Any Files Exist
K|

Group Mumber; |1F‘LAr-I2

Dependent Code |[:.|} |

Card Mo |1 a |

Div/Section Ne. | |

Medical/Dental: Dental w
Eligibility Status: | N Check [l View

1. Enter this information from your patient’s insurance card.

If the carrier supports electronic verification, the Check button shown above will be visible, and you can

click it to check this patient’s eligibility status ; otherwise, you can enter a value in the Eligibility Status text

box.

2. Click the vertical Forms tab, where you can complete the following fields, if applicable.

NIHB

Band Mumber: |

Family Mumber: |

Eligibility Exception Code | rpde not applicable »

The information you enter here is copied to the insurance claim form.

3. Open the Insurance Claims queue either:

e From the Financial menu, select Insurance Claims

e Click on the Show Claims button on the Edit a Patient, Insurance tab.

When you post charges, CDAnet claims are created automatically; the process for creating standard

orthodontic claims has not changed.

4. To create a claim if you are not posting charges, on the Insurance Claims queue, click Add Claim.
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If you have one insurance policy for this patient only, a message box opens, prompting you to specify
whether or not the patient you are submitting a claim for has secondary insurance. This does not affect the
program; CDAnet requires it be there as a reminder for you to ask patients this question.

5. Click Yes or No on the message box.
The policy information is copied over from the patient’s record.

6. Click the Form Fields tab, which is | cenera | wesicaForn rtormation _Fom s |

H CAOD Predetermination Form Prosthesis Material
Where you enter addltlonal | DShuw Exam Amount: Maxillary Prosthesis Material 0
Informatlonl as appllcable to th|S [ cCompleted Mandibular Prosthesis Material ~
patient: | oate: [ |
[CJshow Records  Amount: Predetermination Num: |
. . oge Pl f Treat it Offi ~
The fields in the Initial ] ] Compisted pes et Treamen O e
Date: Paper Onhy
Placements group box change, | R
depending upon what you select. LJEpemTTte XX
. ope Materials Forwarded ~
For example, if Initial Placement sene T
R Eligibility Exception Code | Code not applicable ~
Upper is not checked, a Date el Pacements
fleld appears Where you must [ Needs Upper dgentureicrownibridge
enter a date in the past when it e intial Pacement Upper
was placed DNeeds Lower denture/crown/bridge
7. For carriers that do not support
electronic claim filing, click the

Paper Only check box.

These claims will be displayed in the Insurance Claims queue with two asterisks appended to the claim type
listed in the Claim Type column.

Date Carrier Patient Subscriber Claim Type Status  Reszponse Submitted
|:| 1441559 Test Carrier #2 Hope, Noma F Buddy B Hope Special* MNews 51,052 .65

8. When you are ready to send electronic claims:

a. Click to check the box next to each claim you want to
send.

2 B & |

b. Click the EClaims button and select Send Claims. EClaims | Launch Options
Send Claims

A descriptive warning message is displayed if there were Reverse Electronic Claim

problems sending any of the selected claims.

View Electronic Responses {34}

EOBs and ROTs

From the Insurance Claims queue, you can right-click on a submitted claim and select View Reponses to open a
dialog box from which you view responses from the insurance carrier, such as Explanation of Benefit (EOB),
Claim Acknowledgment, etc. In the screen shot shown below, you can select the response (in this case, an
EOB), and click OK, to open the EOB on your screen, where you can print it, save it etc.
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View Electronic Responses

Patient: |Régen. Simone E |
Subscriber: |F~!égen. Simone E |
Insurance: |Test Carrier #2 |
Created Date:

Submitted Date:

Claim Submitted Amount:

Claim Status: |Subm'rt1ed

Response Date Type

2MTR2021 Explanaticn of Benefit

Okl Ciose |

T

= T

Additionally, the number on the EClaims button is a counter that indicates how many electronic responses you
received but have not viewed.

Note: Responses to claims may not arrive in real time, though you still receive an acknowledgement that the
claim was received. Claims are stored in a mailbox, and using Dolphin’s CDAnet integration, you can download
the content of these mailboxes to check for responses to claims that arrived later in the day. This process is
called a request for outstanding transactions or ROT.

To request outstanding transactions:

1. From the Insurance Claims queue, click the EClaims button, and select View Electronic Responses.

The View Electronic Reponses dialog box opens. From here you can set search filters on specific response
types, claims statuses, insurance carriers, date range, etc. or you can search on <ALL>.

2. Click the Request Transactions button.

The Choose Mailboxes To Check window opens:

Choose Mailboxes To Check

(O Al Cariers/Locations
(® Al Mailboxes Needed
() By Camier o
(O By Location -
Camier Location Mail
“TELUS-B Chatsworth Yes
Accerta Chatsworth Tes
Test Camier #2 Chatsworth Tes
Select Al

You have the option to clear out all of the mailboxes that contain transactions, only the mailboxes from a
specify carrier from one location, or other options on this window.
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3. Click OK.

Post Charges

When you post charges, add any lab fees
associated with those charges so they are
charged in the ledger. You can do this via the
Add Lab Fee button. (If you are using the
Specialty Module, right-click a line on the
charge grid and select Add Lab Fee.) Lab fees
shown on the Insurance Claim screen are
positioned below the charge item to which the
lab fee applies.

Should you need to customize a specific charge
or fix a mistake, click the Edit Line button to
open the Insurance Claim Charge screen. This
screen includes check boxes for Canadian
procedure type codes that you can add to a
specific charge:

Repair of a prior service

Temporary placement

TMJ Service for correction

Implant Service

Appliance lost

Appliance stolen

None of the above (which is selected by default)

Reports

%

General | Medi-Cal Form Information ‘ Form Fields ‘

Date Enqueved:

Claim Type:

Claim Status:

Patient

Policy

Benefit

Override Form:
Accept Assignment

[inciude Ortho Benfit info

Date

1/4/88 7:01 PM Subscriber:

Céleste G Férme

T
Pen¢
- Code: 59333 IS

Description
Date ofGharge:
| Tooth:
© Surface
Quadrant
" Dental Fee

Lab Fee

Amount to Submit:

Quantity To Show:

Procedure Type Codes

[ Repairofa prior service
[ Temporary placement
] T Service for correction
[ Implant Service

[] 2ppliance lost

[] 4ppliance stolen
None of theabave

Quick Mote|

mpleted | Quantity

1/4/1999

1/4/1999 Examin 5 [ 1
17411999 Radiogr-....... i 1
11411999 RETAINERS, CAST METAL [ 1
[ 1

1

Link Claims|ill Add Charge{flll Add Lab Fee|lll Delete Line [l Claim Data | Add Line|

to generate the claim forms in English or French.

What's New in Dolphin Management 10.6

$40.00

Edit Lineg|

31 January 2022 page 26

Leftto be paid: 50.00

(0wl cancel

When we generate Canadian claims forms, we use the Edit a Patient, Language field to determine whether
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